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Micro Focus Visual COBOL SOA for
Eclipse Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Visual COBOL SOA includes support for deploying native COBOL applications as Web services or for
accessing those from J2EE applications under Enterprise Server.

Project templates also enable deployment of Mainframe Subsystem applications to Enterprise Server,
these templates will not work without mainframe subsystem license and should not be used under a Visual
COBOL SOA license.
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Installing the Product

Installing Visual COBOL SOA on Windows

System Requirements for Visual COBOL SOA for
Eclipse (Windows)

Hardware Requirements
The disk space requirements are:

« Approximately 42MB for the Sentinel RMS license server.
» At least 680MB for Visual COBOL SOA.

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
i Note: You can produce 64-bit and 32-bit applications on 64-bit operating systems.

The supported platforms are:

e Windows 7 32/64-bit

*  Windows 8 32/64-bit

e Windows Server 2008 SP2 32/64-bit
¢ Windows Server 2008 R2 32/64-bit

Software Requirements

Note: If you use the Micro Focus Web Installer to install this product, it checks your system and
installs the missing prerequisite software.

» If you use XML Extensions, it has the same requirements as RM/COBOL version 12 for 32-bit
Windows. (See the RM/COBOL User's Guide, Second Edition or later.) Additionally, XML Extensions
may be used in conjunction with Terminal Server.

v+, Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
= For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL SOA client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com/websync/SLM.aspx.
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Installing Visual COBOL SOA for Eclipse (Windows)

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:

* Visual COBOL SOA and COBOL Server SOA cannot co-exist on the same machine.
* Visual COBOL and Enterprise Developer cannot co-exist on the same machine.

Downloading the Product

1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the install instructions and the End User License Agreement.

Installing
To use the Web Installer:

1. Double-click the EnterpriseDeveloperEclipse2l_webinstaller._exe file.

2. Click Start in the Installer window and follow the instructions to install the prerequisite software and the
product.

Alternatively, you can use the setup file on your machine and install the product as follows:

1. Runthe EnterpriseDeveloperEclipse2l.exe file and follow the wizard instructions to complete
the installation.

A full version of Eclipse, with the Micro Focus plugins already installed, will be present in the C:\Users
\Public\Micro Focus\Product Nanme\eclipse directory. On older versions of Windows, Eclipse
might be installed in a different folder, such as for Windows XP, ini nstal | _di r\eclipse.

f Note:

» If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Manager. By doing this you maintain the existing Sentinel RMS license files while adding
the Micro Focus License Manager. If you are unsure about existing licenses on your computer or
removing the Sentinel RMS License Manager, consult your System Administrator. If you want to
proceed, remove Sentinel RMS License Manager by using Windows Add or Remove Programs
and rerun the installation file.

» Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

*  We recommend that you install any updates for the .NET Framework that are available at the
Microsoft Download site.

« If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Visual COBOL SOA but you can install it if you wish.

Installing Into Different Eclipse Packages

Micro Focus Visual COBOL SOA uses Eclipse 3.7. If you have an existing Eclipse 3.7 installation, no
further action is necessary, but if you want to use Visual COBOL SOA in other Eclipse packages based on
version 3.6, you must also install the Visual COBOL SOA update site, and the RSE and AspectJ plugins.
Follow the procedure below to do this.

- Important: We recommend you back up all existing Eclipse configuration files first.
. )

=

1. Install Visual COBOL SOA as directed above.
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2.

3.

Copy the required Visual COBOL SOA resources to your existing Eclipse as follows:

1. Extract the contents of the following . zip files in %ProgramFiles®%\Micro Focus\Enterprise
Developer\eclipse\installer to a temporary folder:

« ajdt 2.1.3 for_eclipse_3.7.zip
e RSE-runtime-3.3.zip

2. Copy the extracted folders to <your exi sting Ecli pse>\eclipse\dropins.

3. Copy %ProgramFiles%\Micro Focus\Enterprise Developer to <your exi sting
Ecl i pse>\eclipse\dropins.

4. Rename each of the folders:

e Fromajdt_2.1.3 for_eclipse_3.7 to AJDTUpdateSite
e From RSE-runtime-3.3 to RSEUpdateSite
¢ From to COBOLUpdateSite
5. Move the the contents of the <your exi sting Ecli pse>\eclipse\dropins
\RSEUpdateSite\eclipse folder up a level (that is, to <your exi sting Ecli pse>\eclipse
\dropins\RSEUpdateSite) and delete the empty folder.
6. Copy the eclipse.ini file in %ProgramFiles%\Micro Focus\Enterprise Developer
\eclipse\installerto <your existing Eclipse>\eclipse, overwriting the existing file.
Restart Eclipse.

After Installing

If you have used Eclipse from the same workspace before, the Eclipse perspective settings are not reset
after installating any Micro Focus product. To pick up any new features, you must reset the COBOL
perspective after installation:

1.

Make sure you are in the COBOL perspective by clicking Window > Open Perspective > COBOL.

2. Click Window > Reset Perspective.
3.
4. Reapply any customizations.

Click OK.

Installing X Windows on Windows

Some features of Visual COBOL SOA for Eclipse on Windows require an X Windows installation, hence
Micro Focus ViewNowX is provided with the product. To install, run the file ViewNow_X_Server.exe in
your Visual COBOL SOA installation. By default this will be in the %ProgramFiles%\Micro Focus
\Enterprise Developer\ViewNowX folder.

ViewNowX requires that your client machine has Microsoft Visual C++ 2008 SP1 Redistributable Package
(x86) installed. If it is missing from your machine, the ViewNowX installation will offer a link to download the
package.

Repairing

If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
Repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1.
2.

From the Control Panel, click Uninstall a program under Programs.
Right-click your Micro Focus product and select Repair.

Installing the Product
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Installing Mainframe Access Server

Introduction

The installation process for Mainframe Access Server uses a single FTP operation to transfer all of the
mainframe software into a partitioned data set that you pre-allocate. When this transfer is complete, the
remaining installation activities are all done on the mainframe. You customize and submit the pre-built
FRESTORE job to restore the product data sets from the uploaded files and then continue with
customization steps to create an operational Mainframe Access Server.

Requirements

e IBM TCP/IP 4.0, or Interlink TCP/IP 3.1 or higher

e two APPLIDs, two TCP/IP ports

« APF security authorization support personnel availability

« Access to a network share with acceptable space for source and data, as well as the ability to access
the IP address and ports used to access MFA

* The following installation-specific variable information:

Variable Description

drive

userid TSO user-ID for FTP to your mainframe

pswd TSO password for the FTP user-ID

your.mainframe.name TCP/IP host name or IP address of your mainframe

prodhlq A NEW high level qualifier that will be assigned for all
Host Connectivity data sets when the new Mainframe
Access product is installed. These are NOT existing
product data sets, but rather brand new files that you
will be creating for this base version.

v, Important: The installation of a new version creates new product run-time data sets before the
=" upgrade is applied. Any existing Host Connectivity 3.01 libraries remain intact, and can be used for
fallback. If you prefer to retain your former production library names and re-use your existing

prodhlg then rename your old libraries beforehand.

Make a note of the maintenance level of your current Mainframe Access Server. Messages
MFMO0001I and MFM0014I1 on the syslog and XDBOUT sysout data set show the maintenance
level at startup. You may need to know what level you are upgrading from when you complete
post-installation customizations for this upgrade.

Install Mainframe Access Server

In the instructions that follow, the information that you must provide is shown as one of the variable names
from the table of information in the previous section. For example, if your high-level qualifier (prodhlq) value
is MY.MFA, then substitute MY.MFA for prodhlg.

Follow these steps to load Mainframe Access Server:

1. Download the installation file from the link in your Electronic Product Delivery email and extract its
contents to a directory on the PC.

2. On the mainframe, allocate a new partitioned data set named prodhlg.UPLOAD to receive the uploaded
files. Use the following data set characteristics for this upload library:

DSORG=PO <=== PDS (partitioned data set)
RECFM=FB <=== record format fixed and blocked
LRECL=80 <=== 80 character record size
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BLKS1ZE=3120 <=== 3120 character block size
SPACE=(3120, (3500,500,50)) <=== allocate blocks (BLKS) size 3120

3500 primary blocks
500 secondary blocks
50 directory blocks

3. On the PC, issue the following FTP commands. The actual text of the FTP prompts and responses that
you see may differ slightly from those shown in this example.

a.

Start FTP:

C:\>ftpyour. mai nf rame. nane

Connected to your. mai nfrane. nane.

220-FTPD1 IBM FTP CS/390 VxRy at YOUR. MAI NFRAME. NAME, hh:mm:ss
220 Connection will close if idle for more than 5 minutes.
User (your. nai nframe. nane:(none)): userid

331 Send password please.

Password: pswd

230 userid is logged on. Working directory is "userid.".

Change the working directory on the mainframe to be the upload library that you allocated:

ftp> cd “prodhl q-UPLOAD"
250 The working directory "hlq.UPLOAD" is a partitioned data set.

Set file transfer type to binary

ftp> binary
200 Representation type is Image

. Set FTP prompting off to transfer all files without interruption:

ftp> prompt

Interactive mode OFfF.

Transfer all files from the extracted \Upload directory to members in the prodhlq.UPLOAD library:
ftp> mputdrive:\upload\f*

200 Port request OK.

125 Storing data set prodhl q.UPLOAD(FXXXXXXX)

250 Transfer completed successfully.
ftp: xxxx bytes sent In X.xx seconds (xXxx.xx Kbytes/sec)

When mput has transferred all files the Ftp> prompt appears. End the FTP connection;

ftp> quit

221 Quit command received. Goodbye.

On the mainframe, verify that all files transferred successfully and that for each Fxxxxxxx file in the
\Upload directory there is a corresponding member in the prodhlq.UPLOAD data set. There should
be 10 members, F1 through to F9 and FRESTORE.

4. On the mainframe, edit member FRESTORE in the upload library, prodhlq.UPLOAD. Follow the
instructions in that member to customize the JCL and then submit that job to restore the product
libraries from the uploaded files and populate your new product runtime libraries.

5. Start Mainframe Access Server.

After installation

Since the program libraries can change between versions, it is necessary to either create new procedures,

or back up the old procedures, and at least modify the DSNQUAL=prodhlqg within your MFA sample started
task procedures as provided by Micro Focus. The prodhlg.LOADLIB and prodhlg.SASC.LINKLIB must both

be authorized.

Verify successful maintenance application by checking the Mainframe Access Server startup message:
MFMO0O11: Mainframe Access V4.00 (BASE ) is active

Installing the Product
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The "(BASE )" indicates the product maintenance level. Also check for "V4.00" in the Mainframe Access
Data Connect server startup message:

MFA3031 MFA/DATACONNECT V4.00 - BASE COPYRIGHT (C) 1987-2012 MICRO FOCUS. ..

When you are satisfied with the new version installation you may delete the UPLOAD data set from your
system.

New parameters and members in the CNTL samples data set

The following updated members are found in the CNTL data set.

MFA sample MFA started task

MFAS *new* sample MFAS started task for Data Connect
MFAAS sample MFAAS application server started task
MFAVTAM sample MFA VTAM definitions

PARMS sample PARMS for MFA started task

PARMSAS sample PARMSAS for MFAAS started task
SERVERS sample SERVERS configuration for MFA
UPQUICK configuration notes

If you are migrating from Host Connectivity 3.01 WebSync 10 or earlier, you may want to retain your
existing CNTL members from your current version as an installation test. You can simply copy the existing
MFA started task JCL and change the STEPLIB to reference the new product libraries. You will however
be required to modify the MFAS started task JCL since the module names for Data Connect have been
changed to allow co-residence within the same authorized library as MFA.

Review the Change Log in each of the new members. Read the documentation for any new parameters in
the Readme and in the updated Mainframe Access Administrator's Guide. Add these new parameters and
other changes to your working copies. If necessary, customize the new parameters for your installation.

Once you are satisfied with the operation of Mainframe Access, you can consolidate the configuration
settings into the new high-level qualified CNTL members.

Uninstalling

Windows
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.

2. Click Uninstall a program under Programsin Control Panel.

3. On versions of Windows Vista and later, click View installed updates in the left-hand pane.
4. Select the product and click Remove or Uninstall, respectively.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Note: The installer creates separate installations for Micro Focus Visual COBOL SOA and Micro
Focus License Manager. Uninstalling only Visual COBOL SOA does not automatically uninstall the
Micro Focus Licensing Manager or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus Licensing Manager as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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UNIX

Note: Before you uninstall the product, ensure that the Enterprise Server Regions and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseDeveloper21.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Manager. Uninstalling the product does not automatically uninstall the Micro Focus Licensing
Manager or the prerequisite software. To completely remove the product you must uninstall the Micro
Focus Licensing Manager as well.

To uninstall Micro Focus License Manager:

1. Execute as root the Unlnstal IMFLicenseServer .sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
i Note:

This release requires the latest version of SafeNet licensing software. See Software Requirements
in this document for more details.

» If you are unsure about what your licensing policy is or what sort of license you require, consult
your System Administrator or Micro Focus SupportLine to obtain a valid license.

Windows Use the Authorization Code, supplied with your delivery notice, to license your product. To do
this:

1. Click Start > All Programs > Micro Focus License Manager > License Management
System.

The dialog box for the Micro Focus License System Administration Tool will be displayed.
2. Click the Authorize tab.
3. Enter your Authorization Code and click Authorize.
4. Close the Micro Focus License System Administration Tool.

If you wish to install the license silently, execute the following after the product has been
installed:

start /wait <install-dir>\bin\cesadmintool —term activate
Aut hori zat i onCode

License for the Integrated Development Environment for Eclipse

Your product is supplied with an evaluation license that typically enables you to use your product for 30
days. While you are using the evaluation license, a dialog will display when you start your product
prompting you to enter the Authorization Code. This code can be found in the Requested License Key
email that is supplied when you order your product. Depending on your product order, you might have
multiple license Authorization Codes. To obtain a full license for Visual COBOL SOA, enter the code that is
printed under Visual COBOL SOA - Visual COBOL SOA for Eclipse.

Note: If you have purchased a Visual COBOL SOA timed license, the license management system
may show these as Trial licenses. This does not affect the license you have purchased.

i Note: An XSERV964 license key is supplied for ViewNow X Server.
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Known Issues

Please, refer to the Known Errors and Restrictions topic in the Product Information section of your product

Help.

In addition, please note the following:

COBOL
Watchpoints

ICETOOL
Emulation

Enterprise
Server

Wait for
Attachment
Debugging

The debugger ignores a COBOL watchpoint that is hit if there is no statement following
the statement that modifies the data on which that watchpoint is set.

ICETOOL emulation for managed code is not available in this release.

On versions of Windows Vista and later, Enterprise Server listens only on the IPv4
loopback address (127.0.0.1). As a result, an attempt to connect to localhost with a
TN3270 emulator such as RUMBA may fail. To work around this issue, in your
emulator's configuration use 127.0.0.1 in preference to localhost or your host
machine's name.

There is an issue with "Wait for attachment" when you use Visual COBOL SOA for
Eclipse to debug applications that run on some Linux/Unix platforms. Eclipse connects
to the debugger on the remote machine, but might not attach to the process to debug
the code.

To work around this issue, ensure that on the remote machine the TMPDIR
environment variable is unset or has the same value for both Visual COBOL
Development Hub SOA server and for the running process you wish to debug. The
Visual COBOL Development Hub SOA server is the server which you started either
directly with the $COBDIR/remotedev/startrdoserver script or indirectly using the
daemon which is started with the $COBDIR/remotedev/startrdodaemon script.

To check the variable used by the Visual COBOL Development Hub SOA server:

1. Open Remote Systems view in Eclipse on the Windows machine.

2. Right-click the Shells element of the server connection to be tested and click
Launch Shell.

3. Inthe Remote Shell view, type echo $TMPDIR in the Command field, and press
Enter.

The value of the TMPDIR environment variable is shown - ensure it is the same as
the one used by the process to be debugged.

Note: The value of TMPDIR used by the Development Hub server cannot be
changed in the remote shell and must be set before you start the daemon or
server.

Known Issues
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Updates and SupportLine

Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support

Additional technical information or advice is available from several sources.
The product support pages contain a considerable amount of additional information, such as:

« The WebSync service, where you can download fixes and documentation updates.
« The Knowledge Base, a large collection of product tips and workarounds.
« Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

y Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need

However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

e The name and version number of all products that you think might be causing a problem.

e Your computer make and model.

e Your operating system version number and details of any networking software you are using.
* The amount of memory in your computer.

« The relevant page reference or section in the documentation.

« Your serial number. To find out these numbers, look in the subject line and body of your Electronic
Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( -dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

Creating Debug Files

If you encounter an error when compiling a program that requires you to contact Micro Focus technical
support, your support representative might request that you provide additional debug files (as well as
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source and data files) to help us determine the cause of the problem. If so, they will advise you how to
create them.
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Disclaimer

Disclaimer

This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2012. All rights reserved.
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